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Apple Keeps Making Its Case for Protecting iPhone Users
by  Adam C. Engst

Last week, Apple stepped up its public response to the FBI’s court order demanding that the company 
develop an iPhone hacking tool that would enable the FBI to brute force the passcode used on the 
county-provided iPhone of one of the attackers in the San Bernardino terrorism case. Apple hired some 
high-profile defense lawyers, who immediately began making the company’s case to the media. CEO 
Tim Cook gave a lengthy interview to ABC News, and the end of the week saw Apple’s carefully argued 
response to the court order — it’s a must-read. Finally, in a similar case in New York State, a new ruling 
casts doubt on the use of the All Writs Act to compel Apple to bypass iPhone security. Much has 
happened since the FBI chose to put Apple in the hot seat, and more will undoubtedly be revealed in 
coming weeks. Here’s what you may have missed.

Apple to Adopt a First Amendment Defense Against FBI Court Order -- Theodore J. Boutrous, a 
high-profile lawyer retained by Apple in its legal battle with the FBI, has said that the company’s defense 
will focus on how the FBI’s court order attempts to compel Apple to create a new version of iOS. Since 
the writing of computer code has been recognized as a form of speech, Boutrous will argue that the 
government is trying to compel speech, something that the U.S. Supreme Court has said violates First 
Amendment rights. (In the 1943 case of West Virginia Board of Education v. Barnette, the Court ruled 
that students could not be compelled to salute the flag or recite the Pledge of Allegiance.) In related news, 
Apple has also hired former Solicitor General Ted Olson for its defense team. Olson served as Solicitor 
General under President George W. Bush, and his wife Barbara Olson died when American Airlines 
Flight 77 crashed into the Pentagon during the 9/11 attacks, giving him a personal stake in the tension 
between civil liberties and security. NPR News interviewed the star conservative lawyer, who asked, 
“What in the law requires us to redesign the iPhone, to rewrite code, to provide an Achilles’ heel in the 
iPhone?”

In ABC News Interview, Tim Cook Calls FBI Request the “Equivalent of Cancer” -- Apple 
continues to make its case against the FBI, with the latest salvo coming from CEO Tim Cook in a 
30-minute interview with ABC News. Cook does a good job explaining away many of the 
misconceptions in the case. Anyone interested in this topic should listen to the interview, which runs first 
in an 8-minute abbreviated version, followed by the full-length conversation with ABC’s David Muir.

Apple Facing More Government Demands to Unlock iPhones -- Although the FBI has claimed 
repeatedly that the request for Apple to help unlock an iPhone used by one of the attackers in the San 
Bernardino terrorism case is just about one iPhone, Apple has revealed that it has received a number of 
other requests from law enforcement for similar services, and is fighting the government’s demands in 
seven of the nine cases. This lends credence to Apple’s argument that the FBI’s larger agenda is to compel 
the company to bypass iPhone security generally, not just for this one iPhone.

Apple to Treat Itself as a Security Risk -- The New York Times says an anonymous source close to 
Apple confirmed that the company is working to block the technical hole that enables the FBI’s request 
for a custom version of iOS. What’s unusual about this vulnerability is that it could be exploited only by 
Apple’s iOS engineering team, leading security experts to suggest that Apple must now view itself as a 
security risk. The only question is how long it will take Apple to implement a level of security that will 
stymie even its own engineers.

Apple Pulls No Punches in Response to FBI Court Order -- Apple has now filed its response to the 
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SIG NEWS

The Saturday SMMUG Special Interest Group 
(SIG) will meet from 10:00 AM to 12:00 Noon, 
Saturday, March 12, 2016, in the Fire Station 18’s 
meeting room at: 6830 Hadler View (a map is 
located at the end of this NL). The meeting will be 
divided in to two parts.

The First part starting at 10:00 will focus on iOS, 
helping everyone become both comfortable and 
proficient with their iPhone, iPad, and iPod 
mobile devices. Starting at 11:00 we will focus on 
the OS X.

All are invited, but new users are especially 
encouraged to attend this free meeting. Bring your 
tips and tricks, questions and suggestions. 

For more information about Special Interest 
Groups (SIGs), go to the SMMUG website.

Scan this QR code to be taken to our 
SMMUG web site

ADVERTISING
You can advertise your business or service 
through the Silicon Summit.

RATES 
Per inch   $10
Quarter page   $15 
Half page   $25 
Full page   $50 
Insert                  $15

A 10% discount is applied for ads that 
run two or more months, except for 

inserts.

Sponsor ing Membersh ips a re a l so 
available to merchants who want to see 
their business name and address listed on 
the front page. Sponsoring Memberships 
are $100 for one year.

MEETING DATES
 

Our regular monthly meetings are on the FIRST 
Tuesday of every month. Upcoming meeting 
dates are as follows:

March 14, 2016
April 11, 2016
May 9, 2016

June 13, 2016
July 11, 2016

August 8, 2016
September 12, 2016
October 10, 2016

November 7, 2016*
December 12, 2016

*Meeting changed to the first week of Nov.
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You can find the previous issues of the 
Silicon Summit posted in PDF format at 
the SMMUG website.

THIS MONTH AT SMMUG

March 14th, 2016
6:00 Q&A Session
6:45 Networking Break
7:00 Communication and Collaboration
8:00 Adjourn
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Announcements

Advanced notice
Bob LeVitus, A.K.A “Dr. Mac” has agreed to come and be the guest speaker for our May general meeting. Be sure to set your 
calendars and invite anyone that you know (present or past SMMUG members, iOS or Mac using friends/non-members, etc.) 
to the meeting so we have a full house for his presentation!

March Presentation
Your smartphone isn’t so much a phone anymore as it is a 
mobile communications device. A panel of SMMUG 
experts will present and discuss many of the most popular 
smartphone apps used today for communication and 
collaboration between corporate employees, family 
members, friends, students, and acquaintances. Included in 
this mix are: Facebook and Facebook Messenger, Skype, 
FaceTime, Snapchat, Cyber Dust, Messages, WhatsApp, 
Slack, Trello, and many more. Come and explore with us 
the new era of individual and group communication and 
collaboration.

Door Prize For The March Meeting:
Router

Club News
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FBI’s court order demanding that the company write a custom version of iOS that would enable the FBI to brute force an iPhone’s passcode. This 
document is far from being a dry recitation of legal technicalities — instead, it provides a clear, careful, and complete rebuttal of every statement the 
government has made. It even calls out those government claims that are patently untrue. The Intercept has extracted eight memorable passages 
everyone should see, and if you have the time, read the full document (linked at the top of The Intercept piece).

New York State Judge Denies Government in Similar iPhone Case -- In a drug-trafficking case in New York State where the government 
sought to use the All Writs Act of 1789 to compel Apple to bypass the passcode security on an iPhone, Judge James Orenstein has denied the 
government’s request. Although this case differs in some ways from the San Bernardino terrorism case in which the FBI is trying to compel Apple to 
unlock an iPhone, both cases rely on the All Writs Act. Judge Orenstein found that the government failed to establish that the All Writs Act permits 
the relief it seeks. He also wrote that Apple was not sufficiently close to the criminal conduct and related investigation, that the burden imposed on 
Apple would be too high, and that it was unclear that the government even needed Apple’s help. In a world where legal precedent is important, 
Judge Orenstein’s ruling stands to support Apple’s position in other cases, at least until it’s appealed to a higher court.

The Power of Preview: Pulling Files into Preview
by Josh Centers and Adam C. Engst

So much criticism has been heaped on the likes of iTunes and Photos that it can be easy to forget the software that Apple gets right — apps that 
are both simple and powerful. There may be no better example of this than Preview, which has been built into OS X from the beginning.

On the surface, Preview is a simple image and PDF document viewer, although it can also open iWork and Microsoft Office files. Beyond that 
veneer of simplicity, though, Preview can do so much more. To get a taste of Preview’s power, let’s take a look at how you open images and 
documents in Preview, starting with the obvious ways and moving on to things you may not know.

Of course, if Preview is your default app for images and PDFs, you can open those files by double-clicking them or selecting them in the Finder 
and pressing Command-O. Or drag a file to the Preview icon, either in the Finder or in the 
Dock. Nothing new there.

Slightly more subtle is opening files through Quick Look, which we covered in detail in 
“OS X Hidden Treasures: Quick Look,” (12 February 2016). In the Finder, select an 
image or PDF file and press the Space bar or Command-Y to open it in Quick Look. Then 
click the Open With Preview button at the upper right.

Although Preview is the default app for most image types and for PDFs, it’s possible that 
another app, like Adobe Reader, has taken over for Preview. If you want to change the default app for a 
file type, here’s how to do that:
1. Select a file of the desired type in the Finder.
2. Choose File > Get Info (or press Command-I) to open the Info window.
3. Under Open With, choose Preview from the pop-up menu (highlighted in red in the screenshot 

below). If necessary, click the arrow to the left of Open With to expand that section.
4. Click Change All to make Preview the default viewer for all files of that type.

But that’s all Mac 101. Let’s look at Preview’s more interesting import options.
Import from the Clipboard -- Since Preview is primarily seen as an image viewer, you’ve probably 

never looked closely at the File menu. Do that and you’ll notice that Preview doesn’t have a plain New 
command, but instead one titled New from Clipboard. That command does just what its name implies: 
it creates a new Untitled document containing the contents of the clipboard. It’s also often dimmed, 
because it can work only when the clipboard contains image or PDF data.

To test this, copy an image from anywhere on the Mac (try Control-clicking an image on a Web page 
in Safari and choosing Copy Image). Then switch to Preview and choose File > New from Clipboard. 
You’ll get an Untitled document containing the image.

It’s less common to copy a PDF, but if you open a PDF in Preview, select a thumbnail in the 
sidebar, and press Command-C, you’ll get that page in the clipboard, and choosing File > New 
from Clipboard will create a new Untitled PDF document with that page.

Here’s another neat trick: if you select a file in the Finder, choose Edit > Copy (or press 
Command-C), and then invoke Preview’s New from Clipboard command, it creates a new 
document containing all sizes and resolutions of that file’s icon. It’s a great way to snag an 
application or document icon!

Using Preview’s New from Clipboard command is far from the only way to create a new 
document containing an image or PDF page, but it’s handy on occasion.

https://epic.org/amicus/crypto/apple/Orenstein-Order-Apple-iPhone-02292016.pdf
https://epic.org/amicus/crypto/apple/Orenstein-Order-Apple-iPhone-02292016.pdf
http://tidbits.com/article/16254
http://tidbits.com/article/16254
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Import from Cameras -- Here’s something you probably didn’t know: Preview can import images directly from cameras and scanners. Better 

yet, in Preview’s eyes, your iPhone or iPad counts as a camera.
To import pictures from a camera, connect it to your Mac via a USB cable, open Preview, and choose Import from CameraName (for instance, 

Import from iPhone).
A window appears displaying thumbnails of the photos on that camera, largely mirroring the look and features of Apple’s Image Capture utility 

(which lives in the Utilities folder 
inside your Applications folder). By 
default, Preview displays the photos in 
a list, with EXIF information like the 
date and time the picture was taken, 
file size, resolution, GPS coordinates, 
aperture size, whether the flash was 
fired, and more. Even if you don’t 
want to use Preview to import your 
photos, it’s a handy way to view all 
that data.

In the lower left, there are buttons to rotate photos, view photos as a list, or view photos as a grid. To rotate a photo, select it and click the curvy 
arrow. You can also adjust thumbnail size with the slider in the 
lower right.

When you want to import the photos, you have two options 
in the lower right. You can click Import All to get everything or 
select a few photos and click Import. Decide where to save the 
images and click Choose Destination to put the pictures there.

Import from Scanners -- If you have a compatible scanner 
attached to your Mac, you can use Preview to import images 
and documents from it. Perhaps not surprisingly, the interface is 
also nearly identical to Image Capture’s. It’s also similar to the 
window that appears when you click Open Scanner from the 
Printers & Scanners pane of System Preferences. If your scanner 
doesn’t appear, you may need to set it up first from within the 
Printers & Scanners preference pane. Once there, you can also 
set Preview to open automatically when you press the Scan 
button on your scanner, assuming it has one.

  With the scanner attached and turned 
on, choose File > Import from 
ScannerName in Preview. If the details 
pane isn’t showing already, click Show 
Details to display a wide variety of 
controls for resolution, size, rotation, 
format, and image correction. You’ll 
probably want to choose a resolution 
higher than 50 dpi (300 dpi is safe if 
you’re planning to print the scanned 
document; you might want to go 
higher for photos).
  Pay special attention to the Auto 
Selection pop-up menu, which has 
three settings: Off, Detect Separate 
Items, and Detect Enclosing Box. 
Preview defaults to Detect Separate 
Items, which is appropriate for 

scanning multiple photos at once but isn’t right for scanning a single sheet of paper. For full-page scanning, choose Detect Enclosing Box, which 
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tries to detect the edges of the paper and lets you adjust the scanned area by dragging the selection rectangle’s handles. If neither does quite what you 
want, you can select the portion of the document to scan manually by dragging out a rectangle, moving it around, and resizing it with its handles. 
For an easier approach when scanning full pages, choose Edit > Select All (Command-A), and then resize the selection.

When everything is set to your liking, click Scan. Preview scans the document and opens it in a new Untitled window. If it doesn’t meet your 
needs — this is where you realize that you forgot to reset the resolution menu from 50 dpi to 300 dpi — close it without saving. Otherwise, save and 
name the document to keep it. If you put multiple items in the scanner, Preview scans them to separate files, all of which are shown in a single 
Preview window.

One last thing. While viewing a PDF, you can add additional pages to it by choosing Edit > Insert > Page from Scanner. The scanning interface 
here is simpler, with only a checkbox to use the scanner’s document feeder, if available; a Rescan button for trying again; and an Add To Document 
button. It’s not clear how Preview chooses resolution in this scenario, but it seems to be relatively high. The page is inserted after the currently 
selected page, though you can also drag it around within Preview’s thumbnail sidebar.

Take Screenshots -- Those who write about technology have memorized Apple’s keyboard shortcuts to take Mac screenshots. Normal people 
who need to take a screenshot only a few times a year should turn to Preview instead. Just as the previous features also appeared in Apple’s Image 
Capture utility, the screenshot capabilities are mirrored in Apple’s Grab utility (also stored in the Utilities folder).

In Preview, choose File > Take Screenshot. There you find three options:
• From Selection: After choosing this command, your cursor becomes a crosshair. Click and drag the crosshair over the screen area you wish to 

capture.
• From Window: Choose this command, and your cursor becomes a camera. Move the camera cursor over a window and the window turns blue 

to indicate that it’s selected. Click to take a screenshot of that 
window. By default, your window screenshots come with a 
large shadow; to remove it, Option-click the selected window.

• From Entire Screen: When you choose this command, a 
10-second countdown begins, which you can cancel by pressing 
the Esc key. Once the countdown finishes, Preview takes a 
screenshot of your entire screen. If you have multiple screens, 
Preview creates screenshots for each one. The timer is useful 
when you need to set up the screen in such a way that wouldn’t 
be possible with an instantaneous screenshot. Although it won’t 
appear in the final screenshot regardless, you can move the 
countdown timer bar around to get it out of your way.
Unlike OS X’s screenshot shortcuts, which dump the 

screenshots on your Desktop, Preview opens each new screenshot 
as a PNG file in an Untitled window, where you can make any 
modifications you like before saving it. Simple, but effective.

Wait, modifications? Yes, that’s right, Preview is also a 
surprisingly full-featured graphic editor too. But that’s a topic for a 
future article. Preview may seem unassuming, but it’s packed with 
useful capabilities, and we’ll be looking at more of them in the 
future.

ExtraBITS

Latest Issue of Bon Appétit Shot with iPhones -- The editors of the venerable culinary magazine Bon Appétit issued an unexpected challenge to its 
photographers for the March 2016 issue: No cameras other than iPhones. Some of the photographers were taken aback, while others were thrilled at 
the opportunity. Without their bulky DSLRs and gear, they were occasionally mistaken for tourists, but they reported mostly positive experiences 
and offered a few tips for making the most of the iPhone’s camera. And the photos look great!

Apple Issues New iOS 9.2.1 to Fix Error 53 -- Apple has issued a quiet update to iOS 9.2.1 to resolve Error 53, which made iOS devices repaired 
by outside parties unusable. Here’s what to do if your iPhone is affected.

Apple Pay Expands to China, Coming to ATMs -- China now has access to Apple Pay, and the demand has been overwhelming. Meanwhile, 
you could soon be able to use Apple Pay to get cash from an ATM. We also have an update on Apple Pay partners in the United States.

https://support.apple.com/en-us/HT201361
https://support.apple.com/en-us/HT201361
http://www.bonappetit.com/people/shameless-plugs/article/march-culture-issue-iphone
http://www.bonappetit.com/people/shameless-plugs/article/march-culture-issue-iphone
http://tidbits.com/article/16273
http://tidbits.com/article/16273
http://tidbits.com/article/16275
http://tidbits.com/article/16275
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OS X Hidden Treasures
Services

by Josh Centers 
Services are one of the oldest ways of extending OS X’s capabilities, dating all the way back to NeXTSTEP, the operating system Apple bought in 

1997 and turned into OS X. But there’s a good chance you’re not aware of services, or have forgotten about the Services menu, since it’s easily 
missed, tucked away as it is in the application menu for most apps. Since that menu mostly contains command like About, Preferences, and Quit, 
many people never look through it closely.

The simplest way to explain services is that they’re a way to invoke features of one app from within another app. Here’s an example. Let’s say you 
want to email a snippet of text (like a passage from a 
helpful TidBITS article on our Web site) to a friend. 
Here’s how most people would do that:

Select the text.
Copy the text.
Switch to Mail.
Create a new message.
Paste the text into the body of the message.
Here’s how to perform that same task using a 

service. In this example, I’m viewing the desired text 
in the Google Chrome Web browser, but this 
built-in service works in most OS X apps:

Select the text.
Choose Chrome > Services > New Email With 

Selection.
This creates a new message in Apple Mail with the 

selected text, in fewer than half the required actions.
What’s great about services is that they work in 

many OS X apps and with all sorts of objects, like 
selected text, graphics, files, and folders. The Services 
menu is contextual, so what you see in it depends on 
what’s selected. In the Finder, the Services menu also 
appears at the bottom of the contextual menu that appears when you 
Control- or right-click on a file or folder.

Managing Services -- To see and manage all services, open System 
Preferences > Keyboard > Shortcuts > Services. Apple presumably chose 
this somewhat odd place for services because services can also be invoked 
with keyboard shortcuts.

Once in the Services view of the Keyboard preference pane, you can 
check and uncheck services to enable or disable them. To save even more 
time, you can add keyboard shortcuts to commonly used services. Select a 
service, click Add Shortcut, and press the desired keys. It can be tough to 
find a simple keyboard shortcut that isn’t already claimed by the Finder or 
another app, but I’ve found that Command-Option-Control, followed by 
a letter, usually works. Some services come pre-configured with their own 
keyboard shortcuts, which can be annoying if the service’s shortcut takes 
over from a command’s shortcut in a particular app — just redefine the 
service shortcut to resolve the conflict.

Frankly, the built-in interface is pretty bad, because you can’t expand 
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the System Preferences window to accommodate a 
lengthy list of services or long service names that end 
up being cut off. Happily, there’s an alternative, a 
utility called Services Manager from 
MacOSXAutomation.com. It’s old, and thus a little 
fussy to install, but it still works fine.

Once you’ve downloaded and expanded the file, 
Control-click the Services Manager Installer.pkg, and 
choose Open from the contextual menu. This is 
necessary if you have Gatekeeper set to allow only 
apps from the Mac App Store and identified 
developers. Once you allow it to run, you can work 
your way through the installer, which places the 
Services Manager app in the Utilities folder inside 
your Applications folder.

Launch it, and you can see that it offers a simple 
interface for enabling and disabling services and 
assigning keyboard shortcuts. Since its window is 
resizable and you can show only services in specific 
categories, it’s far easier to use than the standard 
interface.

If you want to get rid of a service entirely, so it no longer shows up in the list in the Services view of the Keyboard preference pane or in Services 
Manager, Control-click it in either, and choose Show in Finder/Reveal in Finder. For services that are Automator workflows, the ~/Library/Services 
folder will open, and you can just move that service to the trash (Services Manager also has a Move to Trash command in its contextual menu). But 
for services provided by apps, choosing Show in Finder identifies the app containing the service, and the only way to eliminate the service is to delete 
the app. You also can’t delete services built in to OS X.

Adding More Services -- OS X ships with quite a few services, but if you want to expand the number of services in your Mac’s repertoire, the 
good news is that you often don’t have to do any extra work to install them, since many come with apps. Here are just a handful of apps that include 
their own services: BBEdit, Ember, Evernote, GraphicConverter, Nisus Writer Pro, TextExpander, Scrivener, Twitter, and Vox. There are 
undoubtedly hundreds or even thousands more.

Unfortunately, it’s easy to end up with services that 
are broken, due to having been installed by old or 
obsolete apps. For instance, I discovered an Open with 
Pixelmator service, which was exciting because 
Pixelmator is my second-favorite image editor (after 
Preview). Sadly, Pixelmator’s service doesn’t work, but 
I’ll explain how to work around this.

You can also download and install standalone services. 
One of my favorites is DEVONtechnologies’ free 
WordService package, which includes a slew of useful 
services for working with text, things like changing the 
case of selected text, inserting dates, trimming lines, and 
showing statistics. Download the WordService package, 
expand the .zip file, copy the WordService app to your 
Applications folder, and finally double-click the 
WordService icon to install the necessary services. You 
can then enable the included services in Services 
Manager or System Preferences > Keyboard > Shortcuts 
> Services, under the Text heading.

For fans of the Markdown text markup language, 
Brett Terpstra (with help from Joe Workman) offers 
Markdown Service Tools that help you create links, 
format text, and even convert between HTML and 

http://www.macosxautomation.com/services/servicesmanager/
http://www.macosxautomation.com/services/servicesmanager/
http://www.devontechnologies.com/download/products.html
http://www.devontechnologies.com/download/products.html
http://brettterpstra.com/projects/markdown-service-tools/
http://brettterpstra.com/projects/markdown-service-tools/
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Markdown.

Installing Markdown Service Tools is a bit more involved than 
WordService. After unzipping the package, open the 
MarkdownServiceTools2.12 folder. You’ll see a whole mess of 
services, 33 all told. To install just a few, select them, and either 
double-click one or press Command-O. For each, OS X asks 
you if you want to install it or open it in Automator. 
Alternatively, in the Finder, press Option and choose Go > 
Library, and then open the Services folder. Drag the services you 
want to install from the MarkdownServiceTools2.12 folder. 
Either way, I recommend installing only those you need and 
understand, because otherwise the list is overwhelming.

Make Your Own Services -- If you can’t find a service you 
want, you may be able to make your own if you’re handy with 
Automator. In Automator, select File > New, and when 
prompted to choose a type, choose Service. The possibilities here 
are nearly endless, but you don’t have to memorize Joe Kissell’s 
“Take Control of Automating Your Mac” to get started 
(although it’s an excellent reference if you want to learn more).

Here’s how to recreate that aforementioned Open with 
Pixelmator service:

After you’ve started a new service in Automator, search for the Open Finder Items action and drag it into the right-most pane.
Set the Service Receives Selected 

pop-up menus to “files or folders” in 
“any application.” 

In the Open Finder Items action, 
choose Pixelmator (or whatever app 
you choose) from the Opens With 
pop-up menu. If you’re confused, just 
mimic the screenshot below.

Save your service and give it a 
descriptive name. I named mine 
“Open with Pixelmator — Custom” 
to distinguish it from the broken one 
that ships with Pixelmator.

Now, when you select a file or folder 
in the Finder and open the Services 
menu, “Open with Pixelmator — 
Custom” will be an option. You can 
also assign a keyboard shortcut to your 
new service too. I set my shortcut to Command-Option-Control-P, so I can select an image in the Finder and press that hotkey to open the image 
in Pixelmator. Again, you can modify this simple Automator service to open selected files in any application you choose.

Services are an excellent way to tie apps together in OS X, and they’re one of OX X’s hidden treasures, a feature that too few people think about 
and that suffers from Apple’s benign neglect. Nonetheless, services can make you more efficient with the apps you’re already using, and for those of 
you who already rely on services, let me know in the comments which services you find most useful.

Reuse governed by Creative Commons license. TidBITS has offered years of thoughtful commentary on Apple and Internet 
topics. For free email subscriptions and access to the entire TidBITS archive, visit www.tidbits.com.

http://tid.bl.it/tco-automating-your-mac-tidbits
http://tid.bl.it/tco-automating-your-mac-tidbits
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Jeff’s Journal
Text Message Tip by Jeff Jensen

My family uses phone messages quite often. My wife has an iPhone, and both my sons have Android smart phones. 
One of the cool things I learned is that on your iPhone, you can go to “Settings > Messages > iMessage”, and turn that switch on.  This will allow 

you to use the FREE and secure Apple iMessage when communicating with someone who has an Apple device and you are connected to WiFi.  In 
my case, this is my wife. 

Lower down, on that same menu, you should also turn on “Send as SMS”. This setting means that when you are not on WiFi, or iMessage is not 
available, your phone will send the text message via SMS instead of iMessage. SMS is simply a text message sent via your phone provider (AT&T, 
Verizon, etc.). SMS delivery occurs when I am sending a text to one of my son’s Android phones, since Android does not support iMessage. 

These settings seem like a great way to save money since I am still on a pay-as-you-go plan with my carrier T-Mobile. IMessage is FREE, SMS is 
not. However, I discovered just the other day my iPhone is not as smart as I thought it was. 

Here is what happened. I was climbing into my car, preparing to leave Physical Therapy (PT). I wanted to text my spouse to let her know I was 
finished with PT. And, since I was running errands on my way home, I was asking if I could pick up anything for her on my way home? I was 
making some stops on my way home anyway. I knew there was no Wi-Fi in the parking 
lot. 

I touched the Messages balloon on my iPhone, and typed in the message. I pushed 
“Send”. My phone made the usual sliding sound it makes when it sends a message. But 
the message (see Figure) showed up with a blue background, which meant that the 
iPhone sent the message via Wi-Fi and iMessage. But I knew that was not happening. 
No WiFi.

Since I was climbing into the car to go, and I wanted the message sent NOW, I next 
set the iMessage setting to off. This meant I was telling my phone to send the message via 
SMS (I had four T-Mobile bars.). I retyped in the message, and sent it again - via SMS. 
 The green message (a shorter message – I was ticked) showed up, made the proper 
sound, and I knew it had gone out.

About 2 minutes after the green SMS message went out, the red "Not Delivered" 
(under the blue box in the Figure) showed up under the blue message. I was not happy. 

Next time I know I have no Wi-Fi, I’ll set the iMessage setting’s choose switch to off 
first to make sure the message goes out right away via SMS. I recommend you do the 
same.

I know iPhones are not walkie-talkies, but I use my iPhone like a walkie-talkie, for text 
conversations a lot, and that works pretty well. Almost all the time.

As an additional caution, I have found that some folks even use email like 
walkie-talkies. If you are both online, and sending back and forth, that can work. But I 
often take a break from email for a day or two. So if I think we are done conversing, and 
you do not, this can be a problem.

As for conversations via text, all I can say is “Come on, this is the 21st century! The 
iPhone should know there is no Wi-Fi, and switch to SMS automatically. Maybe an 
iPhone 6 would know?  I am using the latest iOS 9.2. Anyway, we want our text 
messages NOW! “
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Previously Downloaded OS X Installers No Longer Work
by Josh Centers

File this one under “Obscure problems that could ruin your day.” TidBITS reader Randy Singer alerted us that due to an expired certificate, OS X 
installers downloaded prior to 14 February 2016 won’t work.

The Apple Worldwide Developer Relations 
Intermediate Certificate is required for all apps in the Mac 
App Store, including OS X installers. When used to sign an 
app, the certificate enables OS X to confirm that the app has 
not been corrupted or modified by an attacker. This 
certificate expired on 14 February 2016, causing error dialogs 
and preventing some apps from launching. Most affected 
apps have already been updated with the new certificate. But 
if you downloaded an OS X installer in case of trouble, you 
may be in for a surprise the next time you try to use it.

Happily, this is an easy problem to fix ahead of time:
Delete any old OS X installers in the Applications folder or 

in other locations (be sure to look on external hard drives too; 
if the App Store detects an old installer, it won’t let you get a 
new one). These installers have names like Install OS X El 
Capitan and Install OS X Yosemite.

Open the App Store app by choosing Apple menu > App 
Store.

Click the Purchased tab. Enter your App Store password if 
prompted.

Scroll down to the OS X installer you want and 
click Download.

The new installers are signed with a certificate that 
expires on 7 February 2023, so it will be quite a few 
years before Mac users are affected again.

Those who have created any bootable install disks 
for OS X will need to recreate them with the new 
installers. Dan Frakes wrote a guide to creating OS 
X 10.11 El Capitan install disks for Macworld.

There is one qualification to all this. Apple won’t allow a newer Mac to download versions of OS X that aren’t compatible with that Mac, so on a 
27-inch iMac with Retina display, for 
instance, the App Store app refuses to 
let you download Mac OS X 10.7 
Lion.

If you are in the middle of an OS X 
install and get tripped up by the 
expired certificate, Randy Singer offers 
a suggestion on how you can work 
around the problem quickly, without 
having to download a new installer:

In the OS X Installer, choose 
Utilities > Terminal.

Enter sudo date 0201010116, press 

Macs & Mac OS X

https://developer.apple.com/support/certificates/expiration/
https://developer.apple.com/support/certificates/expiration/
https://developer.apple.com/support/certificates/expiration/
https://developer.apple.com/support/certificates/expiration/
http://www.macworld.com/article/2981585/operating-systems/how-to-make-a-bootable-os-x-10-11-el-capitan-installer-drive.html
http://www.macworld.com/article/2981585/operating-systems/how-to-make-a-bootable-os-x-10-11-el-capitan-installer-drive.html
http://www.macworld.com/article/2981585/operating-systems/how-to-make-a-bootable-os-x-10-11-el-capitan-installer-drive.html
http://www.macworld.com/article/2981585/operating-systems/how-to-make-a-bootable-os-x-10-11-el-capitan-installer-drive.html
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Return, and enter your password.

Quit Terminal and continue the install.
That Terminal command sets your system date to 1 February 2016 — before the certificate’s expiration — so the installer can continue. Once 

you have completed the installation, visit System Preferences > Date & Time to reset the system date. Thanks to Randy for the heads up on this issue 
and the workaround!

As noted, this expired certificate affects more than just OS X installers — a number of Mac App Store apps suffered from it as well. If 
downloading a new version of an affected installer isn’t an option for some reason, Rich Trouton noted in 2012 that there’s an -allowUntrusted flag 
for the command line installer utility that might help, as might Greg Neagle’s flatpkgfixer.py tool.

As indicated by those posts from 2012, this is only the latest in a series of expired certificate snafus that have rendered Mac App Store apps 
unusable — the last one hit in November 2015 (see “The Mac App Store Is Breaking Apps,” 12 November 2015). Put bluntly, Apple needs to do 
a better job in managing its Worldwide Developer Relations Intermediate Certificate and alerting both users and developers to the implications of 
any expiration or revocation. Having this sort of sporadic failure is decidedly a strike against “It just works.”

What “Error 53” Means for the Future of Apple Repairs
by Josh Centers

In “Error 53 Will Kill Your iPhone and No One Knows Why,” (23 April 2015), I reported on the mysterious Error 53, which makes iPhones 
unusable, with no explanation from Apple. The good news is the community has now pinpointed the cause of Error 53, and it’s easy to avoid. The 
bad news is that the explanation makes the future of repairing your own Apple devices or using less expensive independent repair services even more 
dim.

The cause of Error 53 is a failure within the Touch ID sensor in the Home button of new iPhones. When you restore or update to iOS 9, it 
verifies that the Touch ID sensor is properly paired with the processor’s secure enclave. If iOS detects that the pairing has failed, which it might even 
if only the screen was replaced, Touch ID is disabled to protect the security of Apple Pay, and additional security checks display Error 53 and prevent 
further access.

Pairing the Touch ID hardware with the secure enclave is a clever security measure that ensures no one can access your fingerprint data or Apple 
Pay details by messing with Touch ID. The problem is that if an unauthorized repair center replaces your iPhone’s Home button, or even an 
associated part such as the screen, updating or restoring iOS 9 at some later date will render the iPhone useless. If you run into this situation, Apple 
says to “contact Apple Support about pricing information for out-of-warranty repairs.”

As Daring Fireball’s John Gruber pointed out, Apple could have handled Error 53 better. Instead of bricking the iPhone, iOS 9 should just 
disable Touch ID and Apple Pay, and explain to the user why it did so. In short, there’s no reason to throw the baby out with the bathwater.

We reached out to an Apple Authorized Service Provider who is familiar with the matter. While he confirmed that Apple’s requirement is a 
security feature, he also sees it as Apple pushing several agendas: selling AppleCare+, pushing customers into buying new phones after AppleCare+ 
expires, shutting out non-authorized repairers and suppliers, and shutting out fake devices built from knock-off parts. It turns out that all iPhone 
screen repairs have to go back to Apple for screen replacements; Apple has a machine that restores the pairing between the Touch ID sensor and the 
secure enclave.

We also spoke with a technician at a local independent repair shop, who was outraged that Apple was doing this to customers, particularly without 
warning. He said that his shop is now telling customers that they can either take iPhones that require this sort of repair to Apple or avoid updating to 
a new version of iOS 9. The tech was in fact performing just such a repair during the conversation, and the waiting customer said that he wouldn’t 
have updated the iPhone anyway, so that limitation didn’t bother him.

Apple’s handling of the situation has prompted the Seattle law firm PVCA to file a class action suit against Apple; if you’ve experienced Error 
53, consider getting in touch with them.

The Bigger Repair Picture -- Apple’s discouragement of tinkerers is nothing new. The original Macs were notoriously hard to work on, requiring 
a long Torx screwdriver to open, and after Steve Jobs returned to Apple in 1997, the company’s hardware became ever more difficult for outsiders to 
service.

A key example is Apple’s choice to switch from standard #00 Phillips screws to proprietary pentalobe screws during the iPhone 4’s lifecycle. In fact, 
if you brought an iPhone 4 with Phillips screws to an Apple Store for repairs, Apple would replace them with pentalobe screws.

The funky screws didn’t dissuade most DIYers, and it wasn’t hard to replace the battery in the iPhone 4, but Apple continued down the path of 
making future iPhones even harder to repair, as Adam Engst and I documented in “Replace a Dying iPhone 5 Battery” (5 March 2014) and 
“How to Replace a Cracked iPhone 5c Screen with Screasy” (24 July 2015).

Because of these difficulties, our advice since the release of the iPhone 5 has been to leave repairs to the professionals, even if you think you know 
what you’re doing. Unfortunately, even when going directly to Apple for repairs, things don’t always go smoothly, as I detailed in “Replace a Dying 
iPhone 5 Battery: Take Two” (28 August 2014). A couple of weeks after having my iPhone 5 battery replaced by Apple, the rear camera stopped 
working — I suspect due to a bad connection. Thankfully, it was time to upgrade anyway, so I never bothered trying to fix it.

http://mjtsai.com/blog/2016/02/16/more-mac-app-store-certificate-problems/
http://mjtsai.com/blog/2016/02/16/more-mac-app-store-certificate-problems/
https://derflounder.wordpress.com/2012/05/17/10-7-4-command-line-installer-tool-can-now-install-installer-packages-with-expired-certificates/
https://derflounder.wordpress.com/2012/05/17/10-7-4-command-line-installer-tool-can-now-install-installer-packages-with-expired-certificates/
https://managingosx.wordpress.com/2012/03/24/fixing-packages-with-expired-signatures/
https://managingosx.wordpress.com/2012/03/24/fixing-packages-with-expired-signatures/
http://tidbits.com/article/16081
http://tidbits.com/article/16081
http://tidbits.com/article/15608
http://tidbits.com/article/15608
http://www.theguardian.com/money/2016/feb/05/error-53-apple-iphone-software-update-handset-worthless-third-party-repair
http://www.theguardian.com/money/2016/feb/05/error-53-apple-iphone-software-update-handset-worthless-third-party-repair
https://support.apple.com/en-us/HT205628
https://support.apple.com/en-us/HT205628
https://support.apple.com/en-us/HT205628
https://support.apple.com/en-us/HT205628
http://daringfireball.net/linked/2016/02/05/error-53
http://daringfireball.net/linked/2016/02/05/error-53
http://www.pcvalaw.com/apple-iphone-error-53-lawsuit/
http://www.pcvalaw.com/apple-iphone-error-53-lawsuit/
http://tidbits.com/article/14571
http://tidbits.com/article/14571
http://tidbits.com/article/15807
http://tidbits.com/article/15807
http://tidbits.com/article/15029
http://tidbits.com/article/15029
http://tidbits.com/article/15029
http://tidbits.com/article/15029
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So what’s the takeaway? Sadly, it seems that the era of repairing your own Apple devices continues to wane; if you can repair an Apple device 

yourself, it’s likely either because it’s an older model or a design accident. And as Apple struggles to maintain its revenue growth in the face of slowing 
sales, the company will try to extract money wherever it can, with repairs and service plans as another means to that goal (ask any auto dealer).

Here’s our advice for your future iPhone repair needs:
• Whenever possible, have your Apple products serviced at an Apple Store or an Apple Authorized Service Provider.
• If you’re at all hard on devices, and particularly for portable devices, think about buying AppleCare coverage to extend your warranty.
• Consider the iPhone Upgrade Program (see “Comparing U.S. iPhone Plan Costs in a Contract-Free World,” 11 September 2015) for your 

next iPhone purchase, as it includes AppleCare+ and it lets you replace your iPhone every year.
• If a non-authorized repair is unavoidable or vastly less expensive, be sure to keep your original parts in case there’s a problem. Historically, Apple 

won’t even talk to you if you have third-party parts installed in your iPhone. And if you do need an independent repair that might cause Error 53, 
well, avoid updating to iOS 9 or a newer version of iOS 9. Small bug fixes and security risks are better than a dead iPhone.
However, it’s not all bad news. In order to deal with unauthorized repairs, Apple has drastically reduced the price for out-of-warranty screen 

repairs. Without AppleCare+, the company now charges between $109 to $149 for a screen replacement, which isn’t much more than what you’d 
pay with AppleCare+. However, if you have AppleCare+, Apple will give you a loaner phone and likely move your repair up in its priority list.

El Capitan System Integrity Protection Update Breaks Ethernet
by Josh Centers

Many Mac users were baffled over the weekend when their Mac‘s Ethernet ports stopped working. Thankfully, Apple swiftly published a support 
article about how to fix the problem. The culprit appears to be an update to OS X 10.11 El Capitan’s System Integrity Protection security feature, 
which accidentally disabled the kernel extension that manages the Ethernet port.

Apple pushed out a second update to the Incompatible Kernel Extension Configuration Data that should automatically fix the problem. But if the 
first update disabled your Ethernet port and prevented the second update from installing, follow these steps to determine your situation and fix it:

Hold down the Option key and choose System Information from the Apple menu.
In System Information’s 

sidebar, under Software, 
select Installations.

If the listings aren’t 
arranged in alphabetical 
order, click Software Name 
to sort them.

Look for Incompatible 
K e r n e l E x t e n s i o n 
Configuration Data. If the 
most recent version 
installed is 3.28.1, you have 
the troublesome version, 
and will need to force an 
update to 3.28.2. If you 
already have 3.28.2, as in 
the screenshot below, the 
kernel extension isn’t the 
culprit and you’ll have to 
try another troubleshooting 
method.

If you need to force an 
update to 3.28.2 and have a 
Wi-Fi connection, the fix is easy: Open Terminal in /Applications/Utilities, type the following command, and press Return:

sudo softwareupdate --background
You may be prompted to enter your administrator password. After that, quit Terminal and restart your Mac to finish applying the fix.
If you can’t connect to Wi-Fi or don’t have a Wi-Fi network, then you unfortunately have a more involved process ahead of you, detailed in the 

aforementioned Apple support article.
We’re happy that Apple addressed this issue quickly, but we can’t say that the broken 3.28.1 update gives us warm and fuzzy feelings for the state 

of Apple’s software quality assurance.

https://locate.apple.com/
https://locate.apple.com/
http://tidbits.com/article/15914
http://tidbits.com/article/15914
https://support.apple.com/en-us/HT6672
https://support.apple.com/en-us/HT6672
https://support.apple.com/en-us/HT6672
https://support.apple.com/en-us/HT6672


14

Reviews
Toon Boom Storyboard Pro

by L. Davenport

What are storyboards? Storyboards are sequential illustrations or images (like a comic book) that outline a scene or a script. Hollywood studios and 
individuals (in various fields of interest) use them to organize and pre-visualize their animation or live action movie, TV show, event, motion 
graphics, or interactive media (video games) sequences. This is also a perfect tool for advertisers to pitch their commercial/ad ideas to new clients and 
for playwrights and directors of traditional theater plays to understand the layout of the play’s scenes.

Storyboards can be rough sketches or intricate 3D illustrations. The finished sketches are usually tacked to the wall or a cork-board in long rows 
for quick viewing and easy rearranging.

The Process
In the movie industry, an artist takes the movie script and breaks it up into a series of quickly drawn images which tells the story from the camera’s 

point of view. Storyboards often include arrows that depict the actor’s movement within a shot, occasional notes, and (optionally) includes the 
dialog. Being able to pre-visualize a movie’s sequence allows film directors to spot potential problems with the camera angles or the flow of their 
films. This is more cost effective than to realize the problem(s) after the expensive and time consuming shooting of a scene or entire movie.

With the advent of the computer, storyboards no longer need to be hand drawn. That’s where Toon Boom Storyboard comes into play. It gives a 
storyboard artist all of the tools needed to digitally create and export their storyboards.

Figure 1. This is a screenshot of Toon Boom Storyboard’s main window. Tools surround the Stage View (the area you draw in) and the 
individual panels of the storyboard line the bottom of the window.
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Getting started

When you open Storyboard Pro and create your first project, you can set the: 
Project’s name, Project Directory’s location, The Project Title and Subtitle, the Field 
of View (either vertical or horizontal), and select the Camera Size (pre-defined Width, 
Height, & Frame rates) from a drop-down menu. The available resolution presets 
range from “Low” (360x270) up to “8K_UHD” (7680 x 4320). If your desired 
resolution and frame rate isn’t listed, you can create a custom resolution and frame 
rate. You can also (at a later date) change the resolution, project name, copyright, field 
chart size, and frame rate project properties. So you are not locked into your original 
project properties.

User Interface 
Storyboard Pro comes with different workspace configurations: 3D view, Drawing, 

Horizontal, Overview, PDF Review, Pitch Mode, Timeline, and Vertical. Each 
workspace brings up a different set of tools or views that would be needed for the 
different steps in creating your storyboards. You can even create your own custom 
workspace that contains the set of tools that you use most often. Figure 1 shows the 
default “Drawing View” workspace. This view has all of the drawing tools 
surrounding the “Stage” (the actual drawing area), and the “Panels” (thumbnails of 
the current and previously drawn images) lining the bottom of the window.

Captions
Storyboard Pro’s “Panel” tab (that sits to the right of the Stage) has Captions (text 

fields) that let you add Dialog, Action Notes (the direction the actor will be moving), 
Sound effects, and Notes to your panels. If you start your storyboard from a script 
(imported from a text file or a Final Draft Script), the caption fields are where the 
script is broken down and placed in the various panels, scenes, sequences, and acts of 
your project (more about this later). If the available Caption fields aren’t enough for 
the information that is pertinent to your project, Storyboard Pro also gives the user the 
option to create their own captions. If you want, you can save your new caption layout as the default caption layout. This way you can use it in 
future Storyboard Pro projects.

In addition to text notes, you can also add Voice Annotations (verbal notes) to the panels (these would usually be revision notes that would be 
added by a supervisor or director letting the artist know of any changes to the storyboard). More than one recording can be made for each panel and 
all annotations accumulate in sequence rather than overwriting the previous 
Annotation.

Storyboarding
A storyboard project consist of panels, scenes, sequences and acts. Each of these are 

color-coded for quick identification:
• Panels (a single drawing) represent actions as seen through the camera’s lens.
• Scenes are composed of one or more panels. In animations, there is usually a new 

scene whenever the camera angle changes. With live-action productions, this is called 
a shot. Typically, a new shot is created for things like going from a mid shot to a 
close shot, when the shot goes from the living room to the kitchen, etc.

• A Sequence is a series of scenes that are grouped together (usually by location).
• An Act is one or more scenes and sequences that are grouped together representing a 

story arc.
Whenever you add a new panel (and then draw your images there-in), small 

thumbnails of these panels appear at the bottom of the Storyboard window. This way 
you can quickly see the progression of your story. If you notice that a panel or scene 
would go better in a different location, you can quickly and easily grab the panel or 

Figure 3. Onion Skinning lets you see the Previous 
(red), Current (black), and Next (green), drawings in 
the Stage View.

A

B

C

D

Figure 2. The Panel tab contains the: A: Panel 
information B: Selection information C: Voice 
annotations, and D: Panel Captions (where you add the 
Dialog, Action notes, etc for each panel).
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group of panels and move them to a new location. No redrawing is needed.

Layers
If you have used Photoshop, you should be familiar with the concept of 

layers. If not, layers let you keep your artwork organized and it lets you edit 
individual components of each panel. For example, you can have your 
background on one layer, your actor on a second layer, one or more props 
on the third layer, and so on. By having them on separate layers, you can 
quickly modify the drawing on an individual layer without effecting the 
drawings on the other layers. You can also move one or more of the 
drawings on a layer from one panel to another. This reduces the amount 
of drawing time needed to complete a scene or sequence.

To further organize your layers and to reduce clutter, you can group 
your layers, which places the selected layers under a “Group_1” (etc.) 
heading (you can change this name if you want). An Expand/Collapse 
button is also added to the Group_1 heading. So you can collapse all of the 
sub-group layers to declutter the Layers list.

All of a panel’s layers are displayed (as thumbnails) off to the right of the 
main “Stage” view in the Storyboard Pro window. This way you can 
quickly select the desired layer that you want to continue to draw on or 
edit.

There are several types of layers. The one you choose is dependent on 
the type of graphics you want to use, e.g. Bitmap, Vector, or 3D.
• Bitmap Layers allow you to use/draw graphics which are made of pixels 

(that resemble tiny dots) laid out on a grid.
• Vector Layers let you create graphics that are made of scalable objects and lines (which use a mathematical equation rather than individual dots or 

pixels). Vector objects can be scaled without losing line sharpness (unlike pixel lines that will eventually blur with resizing).

Figure 5. Storyboard Pro lets you draw with both Bitmap and 
Vector brushes. Each style has a different set of brushes and the 
appropriate brushes show up when you click on a Vector or a 
Bitmap layer (that you had previously made). The screenshots on 
the left and top right show some of the Bitmap tips and Bitmap 
brushes. The bottom right screenshot shows the textures that can 
be applied to either Bitmap and Vector of brushes. 

Figure 4. This 3D Workspace View shows the Camera View (top left), Top View (bottom left), and Stage View (right). The Top view is 
showing the (exterior) top of the 3D quonset hut (that I imported into Storyboard Pro) whereas the Camera View shows the hut’s interior 
along with the 2D drawing of the boy and creature fighting. 3D items can be moved along the X, Y, Z axis in 3D space.
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• 3D Layers: You can import 3D objects into Storyboard Pro’s Library. Once there, 

you can drag these 3D objects to your panels. When you do, a 3D layer is 
automatically created and the 3D objects remain intact. 

• When you have multiple layers, (such as layers containing different actors) you can 
have Storyboard Pro blur one or more layers. This way you can draw the viewer’s 
attention to the the person talking, etc.

Drawing
 Storyboard Pro comes with drawing and painting tools along with a wide variety of 

colors and brush tips (Figure 5). This allows the user to customize the Brush Tips’ 
roundness, hardness, angle of the tip, and the randomness of the tip.

You can set the minimum and maximum sizes of your brush or pencil to produce 
the thick and thin effect of your line. This also works with the pressure sensitivity of a 
pen tablet.

Onion Skinning
Storyboard Pro has an “Onion Skinning” option where you can see the previous, 

current, and next drawings at the same time. This lets you compare the drawings to be 
sure that they are uniform in size and position. In Figure 3, the Previous drawing is in 
red (the boy is reaching for the egg). The Current drawing is in black (the boy watches 
the newly hatched creature start to grow). And the Next drawing is in green (the full size 
creature reaches for the boy). 

  Notice how the drawing from the boy’s chest to his feet is almost exactly the same in 
all three drawings. This is one of the advantages of onion skinning - you can trace over 
the previous drawing to cut down on the drawing time (in addition to making sure 
everything is aligned perfectly between the drawings).

Importing Image Files
  Storyboard Pro is set up for the user to draw directly within the program. But if you 

wish, you can create your artwork in another graphics program and then import those  

images into Storyboard. The Supported file formats 
include:  .ai, .pdf, .tvg, .pal, .scan, .sgi, . tga, .yuv, .omf, .psd, 
.png, .jpg, .jpeg, .bmp and .tif. The imported images will 
automatically be placed in Storyboard Pro’s Library.

Included Library images
 As previously mentioned, Storyboard is best suited for 
hand drawn images (whether drawn from within 
Storyboard Pro or imported). But if you don’t have 
artwork that you can import, and can’t draw a stick figure, 
you can use some of the provided 2D content. These 
ready-made Storyboard templates include around 100 Figure 7. The QT Script option lets the user automate a number of Storyboard 

Pro functions which can speed up the completion of various repetitive task. 

Figure 6. Around 100 Actions, Characters, Fxs, Props, 
and Sets are included in the Toon Boom Pro’s 
Library. 
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elements (Figure 6) divided into the categories of: Actions (arrows showing the direction the actor 
will be moving), Characters (two couples and two children along with different views of each actor 
including walking/running poses), Fxs (explosions, laser beams, lightning, rain, and smoke), Props 
(chair, boats, monster, phone, sofa, trees, etc.), and Sets (beach, hall, house, room, street, 
swimming pool). Simply drag them from the Library into your panels and you are up and 
running with your storyboard.

Templates
To help speed up the drawing process, you can create Templates of artwork that you create (by 

placing a copy of this artwork into the Library). From then on you can reuse the drawing over and 
over again by dragging it from the Library onto a panel’s stage view.

3D Objects
As mentioned earlier, you can import 3D objects into Storyboard Pro. The supported 3D file 

formats are: *.osb, *.3ds, *.obj, *.fbx, *.dae (Collada) and *.abc (Alembic) - though the .fbx file 

Figure 8. This screenshot shows my short storyboard exported in PDF format using the 8 
panels per page layout. Below each panel is a text area that lists all of the action notes, dialog, 
etc. that I added to the Caption fields. BTW: I only added color and the 3D quonset hut to 
one panel (for demonstration purposes). I can do the same for all of the panels if I decide to 
finish this story/storyboard.

Figure 9. The PDF Export option has 
templates to print out your storyboard 
panes. The available options range from one 
per page all the way up to 12 per page (for 
overviews).
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format is recommended. Every time you use your 3D object, a 
reference to the original model is used rather than making a 
duplicate. This helps keep down the size of your project. 

3D objects remain fully scalable and rotatable. You can even 
move the camera inside your object. For example, Figure 4 shows 
the 3D Workspace which displays three views: the Camera View 
(top left), Top View (bottom left), and Stage View (right). The 
Top View is showing the (exterior) top of a 3D quonset hut (from 
a set of lunar colony buildings) that I imported into Storyboard 
Pro and then into this panel. Since the 3D object is hollow with 
texturing and items on the inside, I was able to move the camera 
and the 2D drawing of the boy and creature inside the hut.

3D images work good as backgrounds or props for your 
drawings. They can also be used used as a reference for a vector 
drawing that you want to create.

3D Space
Besides the straight-on front view, Storyboard Pro also gives you 

Top and Side views (Figure 11). These are helpful for Multiplane 
scenes where you want to position elements in 3D space (along the 
X, Y, Z axis’ to make one object appear in front of another, etc). 
The Top and Side views contain a V shape representing the 
camera’s field of view. Inside the field of view are horizontal lines - 
one for each object/layer in the scene, e.g. background, actor, 
objects, etc. .

Animatics and the Timeline
Storyboard isn’t a full animation package - thats the purview of 

its sister program Toon Boom Harmony. That said, it does have a 
Timeline that you can use to link you panels and scenes together 
and play them like a movie. These movies/animations are called 
Animatics. The Animatic timelines can have camera movements, 
animation, scene transitions, and sound track layers added to it. 

By default, the timecode format is used to display the timing in 
with the starting timecode of your project set to 00:00:00.00. 
However, sometimes it may be best to use the number of frames as 
a timing value and a later timecode value as the start of your 
project. You can modify the format and default starting time code 
value to suit your needs.

The newly added support for 23.967 NDF Timecode enables 
the seamless transfer of animatics from Storyboard Pro to the 
editing suite.

If you would like to see an example of a Animatic created by 
Storyboard Pro, check out FiveToolStudio’s “Charlie and the 
Nighthawks Episode one” on YouTube.

Audio files
Storyboard Pro can capture audio from a microphone, or import 

it. There are three types of audio files that can be imported: .wav, 
.aif and .mp3. Once imported, they can easily be dragged into the 
Timeline when you are creating your Animatic project. 

Figure 10. The top screenshot was taken from Toon Boom Storyboard 
Pro. It includes my short storyboard along with two short audio tracks. 
The Animatic was exported and then imported into Toon Boom 
Harmony (second screenshot). Storyboard Pro’s XML export format 
works with Final Cut Pro 7 not Final Cut Pro X. But I was able to import 
the Animatic into Final Cut Pro X (bottom screenshot) after using the 
“7toX for Final Cut Pro” program to convert the XML file into Final Cut 
Pro X’s FCPXML file format.

https://www.youtube.com/watch?v=n7u2bjg4GAQ
https://www.youtube.com/watch?v=n7u2bjg4GAQ
https://www.youtube.com/watch?v=n7u2bjg4GAQ
https://www.youtube.com/watch?v=n7u2bjg4GAQ


Camera & Motion
As previously mentioned, the camera is not set permanently in a fixed position, it can move 

along the X, Y, Z axes. This lets you move it to different locations within the 3D space. For 
example, if you have a bird or rocket flying across the stage, you can change the cameras point of 
view to be behind the bird or rocket. Or you can add keyframes to make it look like the camera 
is moving through different layers of trees and shrubs in a forest until it focuses in on the animals 
drinking from a pool of water, etc. Keyframes can help you produce simple or advanced 
motions and trajectories.

QT Script
The QT Script option lets the user automate a number of Storyboard Pro functions which 

can speed up the completion of various repetitive task. The Script Editor view lets you edit 
existing scripts or create new ones (see Figure 7).

Pipeline Integration  / Exporting
Storyboard can create a project from animation scenes created and imported from its sister 

program Toon Boom Harmony. 
If you have a Final Draft script, you can expedite the process by importing the Final Draft 

script. Storyboard will use the script to create the scenes and panes, plus add all of the text in the 
proper captions. 

Storyboard Pro can export your storyboard project and preserve the timing, motions, and 
sounds edited with Storyboard Pro, directly to Adobe Premiere, Avid Xpress, or Sony Vegas 
using the AAF format or to Apple Final Cut Pro using the EDL or XML formats. But be aware, 
the exported XML files only work with the older Final Cut Pro version 7 or earlier. The newer 
Final Cut Pro X uses the FCPXML format. If you are using the newer version, all you have to 
do is get a copy of  “7toX For Final Cut Pro” from the Apple store. This will convert the older 
formatted file to the newer format. I tested it out and it worked perfectly with the exception that 
I had to manually place the audio files in the proper locations in the timeline, which was easy to 
do (Figure 10’s bottom image).

There are several additional export options:
• PDF files: This export includes nine different storyboard template styles/layouts (Figure 9). 

Everything from one panel per page all the way up to twelve panels per page (for overview 
purposes). Some of the layouts include the captions and others don’t. The available layouts try 
to cover the typical storyboard/document standards of popular studios etc. (that you are 
creating the storyboards for). But if the needed layout isn’t available, you can create customized 
layouts. You can also specify the “Export Range” (from one to all of the panels) plus add 
password protection to your PDF file.

• Movie: Once you have created your animatic, you can export it as a movie file to share and 
play back for an efficient timing reference. You can export your movie file in different formats 
(QuickTime, SWF movie (Flash), jpeg, targa) and as image sequences. The default codec 
when exporting to QuickTime is H.264 which is natively supported by Mac OS X.

• Export to Toon Boom: Storyboard Pro can export your animatic as Animate/Animate Pro or 
Harmony scene files. You can export the entire storyboard project or a selection of scenes. 
When the export is ready, you can open it in the destination software. When you first save this 
new scene, the exported file will be converted to the proper format depending on the software you choose. FYI: I sent my animatic to Toon 
Boom Harmony and it showed up perfectly within Harmony.

• Soundtrack: Storyboard Pro lets you can export your project’s soundtrack to an audio .wav file. You can export the different soundtracks as one 
audio file or export all soundtracks separately.

• FBX: Storyboard Pro can export a storyboard project in the FBX format. This allows you to store any motion data (from element motion or 
Camera angles/zooms), as well as the 2D and 3D elements in your scene. Once exported to FBX, you can open the storyboard elements in a 
third-party 3D application and continue to work on them.

• CSV: You can export the data in a storyboard project in the comma separated value (*.csv) file format. You can view this data in any application 
that supports comma separated value files, such as Microsoft Excel. 
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Figure 11. The top image shows actors placed 
at various locations in the Stage View. The 
second “Side View” image and the third “Top 
view” image shows the location of each actor 
(represented by different lines) in relation to 
the camera. The camera can move along the X, 
Y, X axes so it can move forward or backwards 
to work its way through the actors for 
multiplane camera moves.
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Project Backup
In addition to saving your project each day, you can also create compressed backups as a safety net (against possible corruption of the file). This 

also gives you different versions of your project so you can go back and work from an earlier point in your project.

Pitching the Storyboard
The designers of Storyboard Pro have tried to think of everything. This includes adding a Pitch Mode workspace (arrangement of Storyboard’s 

window and tools). This workspace was is created specifically for pitching a storyboard or concept to a group of people. 
The Pitching Workspace’s Stage View is greatly increased (so your audience can see the drawings/Animatic better). Most of the tools (including 

the Finder’s menubar) are removed, Play controls are added to the bottom of the window, the panels are moved to the left of the window and the 
Captions remain on the right. You can add comments to the Captions based on the given feedback. 

About Toon Boom Animation 
Toon Boom Animation Inc.’s award-winning software is the global standard for 2D animation and storyboarding. Customers include Bento Box 

Entertainment, Disney Television Animation, DreamWorks Animation, Fox Television Animation, Mercury Filmworks, Nelvana and The Spa 
Studios. 

The Skinny
Evaluation: I really like Toon Boom Storyboard Pro. You can start drawing on the panels without having to really go deep into learning the 
program - though you really should. It has inspired me to start working on my animation projects again now that there is a way to visually organize 
the storyline etc. before committing to the animation process. I also like that it is compatible with my Wacom Intuos pen tablet. It makes it a lot 
easier to draw the storyboard images.

Requires: Mac OS X 10.8.4  - 10.11 or higher, 2 GHz Intel® Core 2 Duo processor or higher, 500 MB available hard disk space for the software, 
Video card fully supporting OpenGL with 128 MB RAM, Monitor minimum: 1280 x 800, An Internet connection is required for software 
activation.

Company: Toon Boom Animation

Price:  Monthly Subscription: $58      
 Annual Subscription: $456 (saves 33% over the monthly subscription)    
 Perpetual (lifetime) license: $999

Available trial copy

Figure 12. The Timeline view is where you assemble the timing of a scene’s visuals and sounds. You can add sound track layers, as well as edit 
audio files imported into the sound tracks. You can also add transitions and control the playback of a selected panel or the entire storyboard 
from this view.

https://www.toonboom.com
https://www.toonboom.com
https://store.toonboom.com/my-trials
https://store.toonboom.com/my-trials
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Catch Up with the Latest Dropbox Features -- If you thought Dropbox was just for syncing and sharing files, think again! In the course of writing 
the second edition of “Take Control of Dropbox,” Joe Kissell discovered numerous useful Dropbox capabilities that even loyal, long-time users may 
have missed.

New Services Renegotiate Your Connectivity Bills -- A pair of new services will haggle on your behalf to lower your Internet, phone, and TV bills. 
Josh Centers took one for a spin to see how they work, and he offers tips if you’d rather negotiate yourself.Show full article

How to Focus the iTunes Interface on Music -- If you’re overwhelmed by the complexity of iTunes, and long for the days when it was a relatively 
simple music player, check out Kirk McElhearn’s guide to simplifying the iTunes interface. Kirk walks you through hiding unwanted features in 
order to make the iTunes interface more accessible for playing music.

A Review of the Apple Pencil, Drawn with an Apple Pencil -- Drawing on her considerable talents, iMore’s Serenity Caldwell has posted a full 
review of the Apple Pencil, created entirely with the Apple Pencil itself. The review isn’t your usual text-and-screenshots article, but instead a giant 
hand-drawn comic of Caldwell’s own sketches and commentary. She calls the Apple Pencil “the best digital tool I’ve ever used,” illustrating the point 
with numerous examples.

Apple Blocks First Mac Ransomware Attack in Hacked Transmission App -- Version 2.90 of the Transmission BitTorrent client came with an 
unwanted feature: the KeRanger ransomware, which may be the first bona fide ransomware for the Mac. Three days after being installed, KeRanger 
begins encrypting files, and affected users must pay a ransom of 1 Bitcoin (about $400) to get their files back. Thankfully, Apple and the 
Transmission developers worked quickly to mitigate the attack. Apple revoked the stolen certificate used by KeRanger, so it will no longer work on 
Macs protected by Gatekeeper, and the Transmission Project has updated Transmission to 2.92, which automatically removes KeRanger if it’s 
present. If you have Transmission installed, update it immediately, and if you’ve turned off Gatekeeper for any reason, turn it back on by going to 
System Preferences > Security & Privacy and selecting Mac App Store and Identified Developers under Allow Apps Downloaded From. And keep 
good backups!

Apple Launches Support Account on Twitter -- If you’re having trouble with an Apple product, you can now tweet @AppleSupport to get help 
via direct message. So far, Apple’s Twitter team has been quick to respond, having replied to over 2,700 tweets by the second day of the account’s 
existence. Although we have been critical of Apple’s software quality of late, the company has done a great job recently of expanding its support 
options, adding live chat and the @AppleMusicHelp Twitter account.

Backblaze Publishes 2015 Hard Drive Reliability Stats -- Cloud backup service Backblaze has once again shared its internal statistics on the 
reliability of hard drives in its data center. In the cumulative failure data dating back to April 2013, Western Digital’s drives had the highest rate of 
failure, at around 7 percent, while HGST’s had the lowest, at just over 1 percent. However, when looking at 4 TB drives, which now comprise 75 
percent of Backblaze’s drives, Seagate, Toshiba, and Western Digital hover around a 3 percent failure rate. HGST 4 TB drives are again the best, 
with a failure rate under 1 percent, but Backblaze stopped buying those drives because they were replaced with more expensive models.

Quicken Purchased from Intuit by H.I.G. Capital
by Adam C. Engst

Intuit said last year that it was looking for a buyer for its Quicken business, and the company has now announced that Quicken will be acquired 
by H.I.G Capital, a private equity investment firm that has invested in and managed more than 200 companies worldwide since 1993, with 
combined sales of over $30 billion. Quicken head Eric Dunn shared the news and talked about where Quicken would be going in a video.

Dunn was the fourth employee at Intuit, having joined back in 1986, and he said that he’s “very aware that Quicken isn’t perfect,” and that he 
reads comments from customers via email, Facebook, and the Quicken Live online community. To address customer complaints, Quicken is hiring 
a new product manager and will be doubling the size of the engineering team within the calendar year. In its FAQ about the sale, Intuit explicitly 
mentions Mac support, saying:

Meeting the needs of Mac customers continues to be an important priority for the business. In fact, we’ve already identified opportunities to 
increase the size of the Mac development team.

Tidbits
[Click on the blue titles to read the whole story]

http://tidbits.com/article/16298
http://tidbits.com/article/16298
http://tidbits.com/article/16270
http://tidbits.com/article/16270
http://www.mcelhearn.com/how-to-set-up-minimal-itunes-for-music-only/
http://www.mcelhearn.com/how-to-set-up-minimal-itunes-for-music-only/
http://www.imore.com/review-apple-pencil-drawn-review-apple-pencil
http://www.imore.com/review-apple-pencil-drawn-review-apple-pencil
http://www.macworld.com/article/3040987/security/apple-shuts-down-first-ever-ransomware-attack-against-mac-users.html
http://www.macworld.com/article/3040987/security/apple-shuts-down-first-ever-ransomware-attack-against-mac-users.html
https://twitter.com/AppleSupport
https://twitter.com/AppleSupport
https://www.backblaze.com/blog/hard-drive-reliability-q4-2015/
https://www.backblaze.com/blog/hard-drive-reliability-q4-2015/
https://qlc.intuit.com/questions/1328117-update-on-the-quicken-sale-from-eric-dunn
https://qlc.intuit.com/questions/1328117-update-on-the-quicken-sale-from-eric-dunn
http://higcapital.com/
http://higcapital.com/
https://qlc.intuit.com/announcements/1328118
https://qlc.intuit.com/announcements/1328118
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Little else is slated to change. Intuit has a page for questions and comments about the sale, although there aren’t many replies from Intuit reps.
From what’s been said, it seems as though H.I.G. Capital will primarily be an investor, and Dunn says that Quicken will receive increased 

investment over what Intuit was providing. With Intuit out of the picture, users can hope those extra resources will result in more capable versions of 
Quicken appearing more quickly. But caution is still warranted — few apps have promised more and delivered less over the years than Quicken, and 
it’s possible the recent problems are as much with the current team as with Intuit.

Of course, if you’re sick of the Quicken soap opera, there are good alternatives (see “Your Favorite Mac Personal Finance Apps,” 29 February 
2016).

Sparkle Vulnerability Real, but Exploits Highly Unlikely
by Josh Centers

While numerous readers love our regular TidBITS Watchlist feature, in which we track notable updates for key Mac software, many apps no 
longer require you to go hunting for the latest versions as they’re released. Instead, these apps use an open source framework called Sparkle to check 
for, download, and install updates automatically.

Unfortunately, some developers haven’t been careful enough with their implementations of Sparkle, and that could put your Mac at risk of attack. 
Researcher Radosław Karpowicz found that many developers use unencrypted HTTP connections to their servers, which makes 
man-in-the-middle attacks possible. So, a bad guy could sniff out your network connection, insert malicious code, and hijack your Mac via the 
compromised app without triggering Apple’s Gatekeeper security feature.

Sparkle itself isn’t really doing much wrong, since using unencrypted HTTP connections violates this recommendation in its documentation: 
“We strongly encourage you to use HTTPS URLs for the AppCast.” Regardless, the Sparkle team has already updated Sparkle to address the 
vulnerability. The only problem is that getting an updated app with the new Sparkle code requires, well, getting an update, which could expose you 
to the vulnerability.

But don’t panic! To exploit this vulnerability, an attacker would need to be on the same network as your Mac. So if you’re safely in the confines of 
your home or office with an Ethernet or secure Wi-Fi connection, you have nothing to fear. Just keep letting your apps update when they want, and 
as long as you’re on a private network, you’ll be fine.

However, if you often use public Wi-Fi networks without also employing a VPN to secure all your network traffic, you could be at risk if there 
was a sufficiently capable hacker at the next table. That risk would apply for any affected app that has automatic update checking enabled and is 
running. However, using a VPN will keep you safe and should be standard operating procedure when using networks outside your home or office. 
If a VPN isn’t an option, you can also disable automatic update checking in any apps that use Sparkle, and when an update arrives, download and 
install it manually. Since taking advantage of this vulnerability would require a targeted attack, it’s highly unlikely that it would be used 
indiscriminately against people who aren’t high-profile government or corporate officials.

If you are still worried, how do you figure out which apps are vulnerable? People have offered all sorts of Terminal commands to suss out 
vulnerable apps, but the best one I’ve found comes from RussW, a commenter on Mac Kung Fu. His solution checks to see if the app uses both 
Sparkle and an insecure HTTP connection, and then it prints out a list of those apps in a fairly readable format.

Unfortunately, there are smart quotes in RussW’s text that partially break the command (thanks to reader Joe for pointing that out), so I’ve 
created a Pastebin link with the properly formatted command. Follow that link, copy the command under RAW Paste Data, paste the 
command in the Terminal window, and press Return. Terminal will list the vulnerable apps in your Applications folder.

The list may be long, but those who use public Wi-Fi networks can use it to figure out for which apps automatic updates should be disabled until 
a new version is available. At that point, either update manually or re-enable automatic updating only when on a trusted network. Again, this is 

necessary only if you’re paranoid or are concerned about using untrusted networks. And as Security Editor Rich Mogull likes to remind us, if you’re 
in China or are being pursued by the NSA, your data is probably already compromised.

https://qlc.intuit.com/questions/1328113-update-on-the-quicken-sale-discussion
https://qlc.intuit.com/questions/1328113-update-on-the-quicken-sale-discussion
http://tidbits.com/article/16293
http://tidbits.com/article/16293
https://sparkle-project.org/
https://sparkle-project.org/
https://vulnsec.com/2016/osx-apps-vulnerabilities/
https://vulnsec.com/2016/osx-apps-vulnerabilities/
http://www.mackungfu.org/how-to-find-if-your-apps-are-affected-by-the-sparkle-hijack
http://www.mackungfu.org/how-to-find-if-your-apps-are-affected-by-the-sparkle-hijack
http://pastebin.com/4LfdZBMm
http://pastebin.com/4LfdZBMm
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.
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Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($25) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $25.00  APR 1 to JUN 30 - $21.00
 JUL 1 to SEPT 30 - $14.00  OCT 1 to DEC 31 - $7.00

Please Print Clearly!     Today’s Date 

Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc. 
Skip Mundy, Treasurer   
PO Box 62741 
Colorado Springs, CO   80962 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.

http://www.smmug.org
http://www.smmug.org

